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EndNote: How to get started with the new EndNote 20 

Questions and answers 
 

Question Asked Answer Given 

Are current libraries compatible with the new version? Yes! you can open and convert old libraries into the new version. 

Are there any video tutorials for EN20? 
Not yet, but soon will be! Just go to www.youtube.com and search 
for "EndNote 20 tutorial" and you will probably find some in a few 
weeks. And check our support site at: support.alfasoft.com 

Based on the user interface that was just shown, it still 
seems not to be possible to rename PDFs using more 
than 3 fields, without creating additional fields by 
concatenating into a custom field - is this correct? 

Yes, this is correct. The reason is that max 50 characters is used for 
the PDF name. And the reason for this is to avoid an old Windows 
limitation that only allows 256 characters in the whole file path; 
that is all the characters in c://users/name…. including the actual 
file name 

Can a smart group be updated automatically, e.g. find 
new articles on PubMed publish from the same 
author? 

The smart group is updated according to the references within your 
library. The smart group will not automatically download 
references from e.g. PubMed. You can however save a search string 
you make on e.g. PubMed and thus easily reuse the search on a 
regular basis. 

Can EndNote 20 change between an Author-Date and 
a Footnote style? 

Footnotes is a Word functionality and not an EndNote functionality. 
EndNote can thus not change between footnotes and not 
footnotes, but EndNote will in either case format the references for 
you. 

Can folders have subfolders? 
There is two layers, group sets and groups. But you can have 5000 
of each. You can for example also use a tag in e.g. the label field 
and use smart groups to quickly group references. 

Can I host EndNote 20 on a local server for my 
department? what are the minimum hardware 
requirements to run a very large (200,000 reference) 
library? 

You can host the library on a local server (but read the below 
articles first). To access the library each user would by default need 
a licensed EndNote installed but contact us for a specific license 
solution. 
https://support.alfasoft.com/hc/en-us/articles/360001031818-
Share-an-EndNote-library- 

Can I move my EndNote folder to another folder at a 
later stage? If so, do I have to move all the supporting 
folders as well? (EndNote.DATA) 

Yes, you can, but you will need some special care if this is a library 
that is synced to your EndNoteOnline account.  
My tip: Instead of moving, open the library in your EndNote. File > 
Save a Copy, to new location, please choose a different name 
(important!). Then if you use EndNoteOnline sync, choose Tools > 
Sync, and click Ok to "merge library" warning. This last step will 
change sync from old library/location, to new library/location. 

Can it search for policy documents? e.g. disability 
policies in schools UK? 

You can search for any documents you can find in an online 
database. EndNote, however, cannot automatically connect to all 
online databases, and not all online databases are without cost. 

Can several users work collaboratively in a Library? 

Yes, you can share your library with colleagues using 
EndNoteOnline. Read more in the below link of how to create an 
account and sync: 
https://support.alfasoft.com/hc/en-us/articles/360010324578-
How-to-create-an-account-or-connect-to-EndNoteOnline 

Can the highlighted part in a PDF be removed again, 
after it is saved? 

Please see this article: https://support.alfasoft.com/hc/en-
us/articles/360000987418-Remove-your-highlights-or-sticky-notes-
in-PDFs 

Can the three devices that the license works on use 
different operating systems (Windows, Mac OS etc.)? 

Yes, Windows and macOS. 

Can we see in which groups a reference is? 
Highlight a reference, go to the reference menu and choose 
"Reference summary". This will list all groups the reference is 
associated to.  

Can you create your own style in EndNote for citation 
formatting style? 

Yes, and you can change/modify an existing output style. 



Can you run both X9.2 and 20 on the same PC? 

Yes. Have not tested for X9 and 20 specifically since 20 is not yet 
released, but I run X8 (32-bit library) and X9.3 (64-bit library) on 
same computer. Please note the order of installation. If you install 
X8 after X9, X8 will install/take over your Word, and file extensions 
(.enl will open by default in X8 instead of X9). A Win > Control Panel 
> Programs > EndNote X9 > Modify > Repair (= Reinstall) of X9 will 
usually overwrite, but you might also need to change .enl file 
properties (which program to use for open). 

Can you say something about term lists, are they 
necessary to import? 

The Journal name term list with all journal name abbreviations 
needs to be manually imported (is however saved onto your 
computer upon installation. So why are they not activated by 
default? The answer is that there is no standard to abbreviating 
journal names. The abbreviation differs between different 
disciplines and there is thus no default. 

Can you see in which folder an article is stored just by 
searching in the search box? Or you should know in 
advance where you saved it? 

Highlight a reference, go to the reference menu and choose 
"Reference summary". This will list all groups the reference is 
associated to. But regardless you can always search for the 
reference in the "all references" group. 

Can you see overlap articles between folders (within 
the library)? To see which articles are in both folders, 
or is missing. 

Yes, you can create Groups from Groups. E.g. show me all 
references in group A that is not in group B, etc. 

Do I have to use Firefox as web browser? 

No, you can use Firefox, Chrome, Internet Explorer, or any other 
web browser. We recommend Firefox because we think it is easier 
to understand what happens to downloaded files in Firefox, but 
this is an opinion and tip. 
Safari, however, does not support all techniques used. 

Do the old EndNote versions give a message when 
EndNote 20 is available for download? 

No. Only gives messages for available updates on same version, i.e. 
X9.3.3 -> X9.3.4 

Do you recommend having more than one library? Is it 
possible to sync from more than one library? 

We recommend having only one (main) library. You can use 
EndNote's group and set features to create "sub-libraries" within 
your main library if you like. You can only sync one library 
(EndNoteOnline only has one library per account). 

    

Has the maximum number of full-text references you 
can search for at once been increased in EndNote 20? 

Not to our knowledge, it is still 250 references in each go. 

How can we work collaboratively: several users in the 
same library at the same time? 

We recommend using the internal sync functionality via 
EndNoteOnline. Read more in the below article. 
https://support.alfasoft.com/hc/en-us/articles/360010573838-
Different-ways-to-share-an-EndNote-library 

How do you rename it from Bibliography to Reference 
List? 

Click on the small arrow in the lower right corner of the 
"Bibliography" group in the EndNote toolbar in Word. The 
“Configure bibliography” icon/button. 

How many PDFs can the EndNote library hold? 
As many as your computer storage can hold, or max. 999 999 
references in a library. 

I am registered with University of Nottingham 
Education Dept, and when I wish to use EndNote to 
search for articles or books I cannot find which online 
search catalogues to use from the EndNote 
Dropdown, or how to use my university login 
credentials to access via EndNote? Any advice? 

Please talk to your library at your university. This differs from 
university to university. 

  



I am trying to retrieve some papers through the 
PubMed under the online search. I am given a 
"confirm online search", I click Ok, but nothing 
appears. Any idea of why this is happening? 

PubMed sometimes update their database interface. Make sure 
you have updated EndNote to the latest version and make sure you 
are using the latest PubMed connection file. Find information how 
to update the connection file in the below articles. 
For Windows: https://support.alfasoft.com/hc/en-
us/articles/360001368718-Add-additional-Output-Styles-and-
other-files 
For Mac: https://support.alfasoft.com/hc/en-
us/articles/360001365197-Add-additional-Output-Styles-and-
other-files 

I have a Mac and currently have EndNote X8. I have 
not upgraded to Catalina yet. In terms of compatibility 
which system should I have for EndNote 20? 

EndNote X9.3 and EndNote 20 are Mac OS Catalina and 64-bit 
compatible. 

I have a question about syncing to EndNoteOnline and 
database record numbers. My experience in X8 was 
that if I had 4 references, deleted one and added 
another, my record numbers would be e.g. 1, 2, 3, 5.  
When I synced online, the record numbers would 
renumber to 1, 2, 3, 4 etc. creating an offset compared 
with the local version. This meant that if I had refs that 
had the same author and year, Word would have to 
ask exactly which reference I (or my collaborators) 
meant which got unworkable very quickly given the 
size of the document we were working with and the 
number of references in the library with the same 1st 
author surname and year. Has this behavior changed 
in more recent versions? 

It should still work for you, but I have some tips to possible easy 
any troubles you may encounter. 
1. Share your library and see this article (it is only in Swedish so far, 
but you can possibly use translation in Chrome): 
https://support.alfasoft.com/hc/sv/articles/360001017537-Jobba-
med-ett-EndNotebibliotek-och-ett-dokument-p%C3%A5-olika-
datorer 
2. Use another identifier instead of record number (if only record 
number exist EndNote will use record number). In EndNote: 
Edit>Preferences>Temporary citations, choose accession number 
instead of Record Number. 
Please also read these articles: 
https://support.alfasoft.com/hc/en-us/articles/360003850537-
Explanation-of-EndNote-Record-Numbers-db-id-guid-and-the-
workings-of-shared-libraries-groups-and-working-together-in-
same-Word-document 
 Swedish article, use Chrome to translate: 
https://support.alfasoft.com/hc/sv/articles/360001031178-Olika-
nummer-f%C3%B6r-att-identifiera-publicerade-dokument-i-
EndNote 

I often get an error message that my library is 
damaged. What could be wrong? 

Please save your library on your local computer, in a folder that is 
NOT synced by other services. Please note that on Macs the 
Document and Desktop folders are synced by iCloud. We 
recommend saving a library in the Home folder on Macs. Damages 
library error messages probably means you have saved your library 
in a folder that is synced by other services damaging your library, or 
on a server with not optimal network communication. 
Read more in this article: https://support.alfasoft.com/hc/en-
us/articles/360001311578-Storage-location-for-EndNote-libraries 

I thought there was a limit to the number of PDF that 
could be synched? 

Basically, not if you have an EndNoteOnline premium account. 
Don´t know what account you have, see this article: 
https://support.alfasoft.com/hc/en-us/articles/360002814958-Do-
I-have-an-EndNoteOnline-premium-account- 

I would like to know if there is an UNDO button in the 
new version. For example, to undo "delete 
duplicates".  

There is no "undo" button, but all references you delete are 
sent/saved to the "trash" in EndNote and can be recovered from 
the trash. 

I have EndNote X8. Can I still purchase the upgrade to 
End Note 20? 

Yes, if you upgrade within the specified time limit from version X7 
or X8 to X9 now, EndNote 20 will be included. 

If I bought EndNote X9 just before the summer, 
although I will not get a free update, will there be any 
discount available for upgrading if we purchased X9 
this year? 

There is an upgrade price. So, you do not need to pay the upgrade 
price again.  

if I buy EndNote, can I use it on two computers?  Yes, an EndNote license can be active on up to three devices.  

if I have a 5-person multiuser license, can each 
member of my 5-man team install on a maximum of 
three devices (i.e. office and personal computer)? 

Yes, but of course the maximum number of users is still 5.  



If I have duplicates that are associated to different 
groups, what will happen if I remove them? 

If you delete a duplicate it will get deleted from your library and 
any groups, it is associated with. This is a good reason why you 
should search for and delete duplicates "often" and regularly. What 
you can do drag and drop the references between groups. EndNote 
will not create duplicates in the same group. 
You can also create groups based on groups to identify any 
overlapping references, like show all references in group A that is 
also in group B.  

If I just bought EndNote X9 this year, do I need to pay 
for this upgrade? 

If you bought EndNote X9 in the end of August this year or later, 
you can expect a free upgrade.  

If I´m affiliated to a University and search via their 
website, does it matter if I use Safari or Firefox? 

No, but know some techniques do not work with Safari as Apple 
has decided not to support these techniques. We recommend 
another browser, like Firefox or Chrome. 

If my university has a configuration of Harvard style, 
how can I adjust EndNote to reflect that, rather than 
have to do it all manually afterwards? 

Your University should have an EndNote style you can download 
for you!? If not, you can adjust any style in EndNote under 
Edit>Output Style>Edit "name". 
Just remember to save first save the style with a different name 
(important). 

if you access a PDF by URL, how do you store it in 
EndNote? 

Save it to your computer, and then attach it to your library (drag-
and-drop to EndNote) or File > Import > File. Import option = PDF. 

In EndNote 20, are record numbers kept when syncing 
to different computers? 

No, record numbers are unique for each individual library 
(technically this must be the case in a database). But if you sync a 
library between computers and also a Word document this is no 
problem, just click update bibliography in the EndNote toolbar in 
Word. 
We have a Swedish article about this (will soon be translated), you 
can possible read it with Chrome and translate it. 
https://support.alfasoft.com/hc/sv/articles/360001017537-Jobba-
med-ett-EndNotebibliotek-och-ett-dokument-p%C3%A5-olika-
datorer 

In EndNote 20, when making a custom output style, 
for example a tab separated style, is it possible to have 
more than one version of author formatting within the 
same style? e.g. first author without initial and all 
authors with initials? 

Yes and No. You can re-use the author field in multiple locations in 
your edited style, but how the authors are shown is specified for 
the whole author field and will be the same for all uses of the field. 
Our suggestion is to create two variations of the same output style, 
with two different author formatting, and then merge author 
columns afterwards. 

is EndNote 20 able to cite while you write manuscripts 
in MS Word 64 bit and office 365? 

Yes, System requirement and compatibility with OS and Office has 
not been communicated yet, but this should not be a problem.  

is EndNote 20 available to download (via previous 
purchase/upgrade) now? I haven't received my link to 
download? 

EndNote 20 will be available soon. If you purchased EndNote X9 
recently or pre-ordered EndNote 20 you will get the software and 
your license information delivered via email the coming weeks. 

Is EndNote integrated in Power point in the same way 
as in word? I can't seem to add the reference list in 
the same way. And I am unable to update the 
references... 

EndNote is integrated in PowerPoint, but not the same way as for 
Word. Only one way (insert formatted citations and bibliography) 
from EndNote to PowerPoint. No link back to EndNote after 
inserting into PowerPoint, so can't automatically update. 

Is it possible to back up EndNote both locally and 
online when you have synching set up? 

Yes, for a backup it is preferable to use the compressed library 
function (under file in EndNote). See this article: 
https://support.alfasoft.com/hc/en-us/articles/360000976357-
Make-a-backup-of-your-library 
You also just open your library in EndNote, and choose File > Save a 
Copy, and save a copy/backup of your library to other device or 
memory stick. 

Is it possible to remove highlights from EndNote 20? I 
cannot remove the markings from EndNote X9. 

Yes, please see this article: https://support.alfasoft.com/hc/en-
us/articles/360000987418-Remove-your-highlights-or-sticky-notes-
in-PDFs 

Is it possible to use EndNote for both footnotes and to 
create a bibliography?  

Yes, EndNote can use footnotes or author-year styles, and format 
and create bibliographies. 



Is it still necessary to share your whole library in 
EndNote 20 if a colleague wishes to see and use some 
of your references? 

Well, you can always share just a group. Or you can create a 
compressed library containing only selected references (or 
everything in a specific group) and then send this compressed 
library to the colleague. 
For instructions on how to compress a library see this link: 
https://support.alfasoft.com/hc/en-us/articles/360000976357-
Make-a-backup-of-your-library 

Is the Bibliography always added at the end of the 
document?  If so, can it be moved to another location 
of the file? 

By default, the bibliography is generated and added to the end of 
your document. But you can cut&paste it to new position in your 
document, and it will stay there, even if you add new references or 
update/change style. If you cut-paste the bibliography it is very 
important that you include the row above the title of the 
bibliography, this is where the code is that tells EndNote where to 
put the bibliography. 
You can also edit style to add bibliography after each section in 
your document (and a full bibliography at the end). 

Is the interface always black or can it be changed? 
As far as we know it is black, but it might be able to change in the 
actual released version. 

Is the new layout equal on a Mac? 
Yes. We have not seen the Mac version yet, but our understanding 
is that it will look the same or very similar on Mac and Win. 

Is there an advantage using multiple libraries in 
EndNote, or instead using multiple Groups in one 
library? 

Having just one main library is less confusing (less probably for 
mistakes, working/adding references to library A when you thought 
you were working/adding libraries to library B). And you can use 
groups and sets to create "sub-libraries" in your main libraries, if 
needed. Main reason is probably that you can have only one library 
in your EndNoteOnline library (you can only sync one library). 

Is there an UNDO button to reverse movements? 
(moving a folder to the wrong folder is a common 
mistake that messes up the library) 

There is no "undo" button, but all references you delete are 
sent/saved to the "trash" in EndNote and can be recovered from 
the trash. 

Libraries can be saved in Dropbox? Can different users 
work at the same time in the library? 

No, we do NOT recommend saving a library to Dropbox, OneDrive, 
iCloud, etc. folders. The sync from these services can/will damage 
your library. You can save backups of libraries to these services, but 
if you want to open a library, move it to your local computer in a 
folder with no other sync services, and then open and work in your 
library. 
Read more about ways to share a library here:  
https://support.alfasoft.com/hc/en-us/articles/360001031818-
Share-an-EndNote-library- 

Noticed that you have several libraries. Is it 
recommended to have only one library? 

Yes, this will spare you future confusion and you can also only sync 
one library to EndNoteOnline account. 

Please could you confirm whether the 'curly brackets' 
unformatted citations format is still the same as in 
previous editions? 

Yes, confirmed. This is unchanged. 

So how can I update my EndNote to version 20? 
Download it on the website?  

If you have upgraded to EndNote X9 recently, you will get the new 
version when it is launched (in a few weeks). 

The Clarivate best fit journal that is being shown now - 
is this available to all users, or is an additional 
subscription required? 

This is available to all users with the present version of EndNote. 

The DOI format comes into EndNote differently 
depending on the databases you are using, e.g. 
starting with 10. starting with http://DOI.org/ and 
starting with http://dx.DOI.org/ I appreciate that you 
can search and replace within the field to standardize, 
but was wondering if there are any plans to streamline 
this, as the most common use case for deduplicating is 
when you have results from multiple databases. 

How the DOI is presented is how it is saved/exported from the 
online database, and unfortunately there is no standard. I will bring 
your idea to the producer of EndNote. Thank you for your input. 



What about changing from inline citations, as he is 
doing now, to footnotes. Is it possible, or do you have 
to decide beforehand between these different 
systems? 

No, sorry. You will have to decide author-year OR footnote style, 
before you start writing. There are some Word macros out there 
though, but complex to change from author-year to footnote style 
afterwards. The reason is that footnotes is a Word function and 
citations/references is an EndNote function. EndNote will however 
format your references for you.  

What is the advantage of groups instead of separate 
libraries? In an organization of 25 employees and at 
100s of projects it would be huge library if we were to 
make groups instead of separate libraries... 

The need and thus the solution will always differ. Why we 
recommend only one library is because it often get confusing to 
have multiple libraries (what library contains what reference, is 
used to what document, etc.). You can also only sync one library to 
each EndNoteOnline account. Further any search in a library will 
not include references in other libraries, unless they are all opened. 
But apart from this there is no "problem" in using multiple libraries. 

Where are PDFs stored? Are they placed in individual 
folders with random numbers like before? 

Yes, they are copied and placed in the EndNote library DATA folder. 
One PDF/attachment to each numbered subfolder here. 

Will EndNote import author DOI details, if the PDF 
doesn't have the details embedded in the PDF? if not, 
can you manually index a PDF to add authors/titles? 

If the PDF does not have any DOI embedded EndNote cannot find 
the reference information automatically. You can manually edit the 
reference (with your PDF attached) afterwards and it might be 
enough to copy the title from the PDF and use the "Right-click 
reference > Find reference update" function. 

Will the interface be identical between PC and Mac? 
Yes, the message we got from Clarivate is that it will be the same. 
But nothing confirmed just yet. 

Wonder about the function groups share by others- 
can one library be shared with colleagues and I can I 
see their comments and highlights? 

Yes, the built-in sharing functionality allow you to share everything 
(or just a group) with colleagues. It also allows you to set Read-only 
or Read&Write rights for the references. Sharing the whole library 
will give everyone access to attachments as well. 
Read more here: https://support.alfasoft.com/hc/en-
us/articles/360001031818-Share-an-EndNote-library- 

You mentioned that Firefox works well with EndNote, 
are there more browsers? Chrome? 

Basically, any browser works, we just prefer Firefox because it is 
easier to understand what happens to downloaded files. Just be 
aware of Safari as it does not support all techniques. Comment: “I 
prefer Chrome.”, Torgrim, EndNote expert, Alfasoft, Norway. 

 

 


